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This startup guide will help you get your POS system,

including electronic processing of credit and debit

transactions, up and running. Follow the seven

major steps laid out in the following sections and

you’ll be ready for business!

CHAPTER 1
1



Overview
A typical retail store’s POS system is set up using two or more computers. One computer is 
placed in a non-public, back-office area of the store. The other computer(s) are set up as 
terminals in the public area of the store where you and your customers carry out 
transactions.

On your back-office computer

1. Installing QuickBooks ........................................................................ Page 5

2. Installing QuickBooks POS for Retail Administrator......................... Page 7

On your register/terminal computer

3. Setting up Sales Terminal Hardware .................................................. Page 9

4. Installing QuickBooks POS for Retail................................................. Page 11

5. Setting up Electronic Processing of Credit and Debit Transactions.. Page 13

6. Entering Credit and Debit Card Transactions ................................... Page 16

7. Completing the End-of-day Process .................................................. Page 19
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Hardware and software requirements

* Microsoft Internet Explorer 6.0 can be installed from the POS installation CD and requires 
an extra 70 MB of disk space. Adobe Acrobat Reader can be installed from the QuickBooks 
installation CD and require an extras 10 MB of disk space.

** For more information see ‘Using an IP connection for your credit and debit transactions’

*** Microsoft Internet Explorer 5.5 or greater is required to install and operate QuickBooks 
POS for Retail. Microsoft Internet Explorer 6.0 can be installed from the POS installation CD 
at \Ie60\ie6setup.exe.

Hardware/
Software

QuickBooks
POS for Retail 
Administrator

POS for Retail

Required IBM Compatible
200 MHz
Pentium Processor
64 MB RAM

IBM Compatible
200 MHz
Pentium Processor
64 MB RAM

IBM Compatible
200 MHz
Pentium Processor
64 MB RAM

Recommended IBM Compatible
350 MHz
Pentium II Processor
96 MB RAM

IBM Compatible
350 MHz
Pentium II Processor
96 MB RAM

IBM Compatible
300 MHz
Pentium Processor
64 MB RAM

*Free Hard Disk 
Space

205 MB 220 MB 105 MB

CD-ROM 2x (double-speed) or 
faster

2x (double-speed) or 
faster

2x (double-speed) or 
faster

Monitor 256 Color VGA or SVGA 
video or better, 800x600 
resolution or higher with 
small fonts

256 Color VGA or SVGA 
video or better, 800x600 
resolution or higher with 
small fonts

256 Color VGA or SVGA 
video or better, 800x600 
resolution or higher with 
small fonts

Printer Any printer supported by 
your operating system

Any printer supported by 
your operating system

Any printer supported by 
your operating system

Supported 
Operating Sys-
tems

Windows 98, ME, 2000, 
NT 4.0 (with Service Pack 
6a), or XP

Windows 98, ME, 2000, 
NT 4.0 (with Service Pack 
6a), or XP

**Windows 98, ME, 2000, 
NT 4.0 (with Service Pack 
6a), or XP

***Web 
Browser

Microsoft Internet 
Explorer 6.0 or higher

Microsoft Internet 
Explorer 6.0 or higher

Microsoft Internet 
Explorer 5.5 or higher
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Connection requirements for electronic processing of 
transactions

Using a dial-up connection for your credit and debit 
transactions

If you are using a dial-up connection for your electronic processing of credit and debit card 
transactions, you will need at least three COM ports, one for you receipt printer, one for 
your PINpad, and one for your modem (this may be an internal COM port if you have an 
existing modem). If your PC has less than three COM ports, you can purchase a COM port 
splitter (PCI card) from most computer hardware retailers.

If you are using a dial-up connection for electronic processing of transactions, it is strongly 
recommended that you have a US Robotics modem installed on your computer. 
QuickBooks POS for Retail only supports US Robotics modems.

Using an IP connection for your credit and debit 
transactions

If you are using an IP connection for your electronic processing of credit and debit 
transactions, you cannot use Windows 98 or ME as your operating system. Windows 98, 
ME and previous versions of Windows 9x do not support IP VPN connections.

If you are using an IP connection for electronic processing of transactions, it is 
recommended that you have a high-speed internet connection.

For more information regarding electronic processing of transactions using an IP 
connection, contact Intuit technical support.

Contacting Intuit Canada

Phone Support

You can contact Intuit Canada at 1-800-250-9845 from 8 am to 8pm EST, Mon. through Fri. 
POS customers are entitled to 30 days of unlimited setup support for FREE. For a 30 day 
period from the time you register, you can call back as many times as needed to get your 
POS system up and running.

Website support

For the latest information about QuickBooks, please visit our online support web site: 

http://www.intuit.com/canada/quickbooks/support.shtml
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1. Installing QuickBooks 
You must install QuickBooks and create your company file before you can install POS for 
Retail Administrator.

If you do not own QuickBooks or own a previous version 
(QuickBooks 2002 or earlier)

If you have purchased the QuickBooks Point-of-Sale Complete Solution for Retailers 
hardware bundle, you have already purchased QuickBooks 2003 and can go to step 2.

1 To purchase the latest version of QuickBooks, contact Intuit Canada by phone at 1-888-
333-8580 or visit your local software retailer.

When you have received your copy of QuickBooks:

2 Place your QuickBooks 2003 CD into your CD ROM drive. The QuickBooks Windows 
installation should automatically start. If it does not, navigate to your CD-ROM drive 
and double-click ‘setup.exe’.

3 Follow the on-screen steps to install QuickBooks. For full QuickBooks installation 
instructions, refer to the QuickBooks Startup Guide on Page 1.

4 Once you have installed QuickBooks 2003, open QuickBooks and select Register Quick-
Books from the File menu. The Product Registration dialog appears.

5 Choose how you would like to register by clicking ‘Online’ or ‘Phone’. Follow the steps 
on the screen to complete your QuickBooks registration.

If you have purchased, installed, and registered QuickBooks 
2003

For optimal usability and functionality, QuickBooks 2003 R5 or greater should be installed 
on your back-office computer.

� To check which release of QuickBooks you have, open QuickBooks and press CTRL+1. 
The Product Information dialog appears. Make a note of what appears in the ‘Product’ 
line.

If you have QuickBooks 2003 and the release number is R5 or greater or you have one of 
the QuickBooks Premier 2003: Custom Editions (for example, Retail or Professional 
Services), you are ready to create a company file. If your release number is R4 or less you can 
either:
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Automatically update QuickBooks

This process requires an internet connection.

1 Open QuickBooks.

2 From the File menu, select Update QuickBooks. The ‘Update QuickBooks’ browser 
window appears.

3 Click the ‘Update’ button on the bottom right corner of the window.

4 Click the ‘Get Updates’ button. The status bar at the bottom of the window shows the 
status of the update. When complete, the status bar displays ‘Update Complete’. 

5 Shut down and restart QuickBooks to install the update. You are now ready to create a 
company file.

Install QuickBooks R5 from the POS 3.0 Installation 
CD

If you do not have an internet connection, you should install the latest QuickBooks release 
from the POS for Retail 3.0 installation CD.

1 Insert your POS 3.0 CD into your CD-ROM drive.

2 Navigate to the CD-ROM drive in Windows Explorer. Open the folder ‘QBooks’ and 
double-click ‘setup.exe’.

3 Follow the on-screen instructions to install QuickBooks 2003 R5. When prompted to 
enter your installation key code (IKC), use the IKC that was provided with your original 
QuickBooks 2003 purchase. When the R5 installation is complete, you are ready to 
create a company file.

Creating a company file

It is necessary to create a company file in QuickBooks before installing and setting up POS 
for Retail Administrator. Without a QuickBooks company file the POS for Retail 
Administrator installation will fail.

For more information about creating a company file, see ‘Setting up a new company’ on 
page 31 of the QuickBooks Startup Guide.

It is necessary to setup QuickBooks inventory before using POS for 
Retail.

For more on setting up QuickBooks inventory, see “QuickBooks - Inventory” 
on page 20 of the POS User’s Guide.
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2. Installing QuickBooks POS for Retail 
Administrator

Installing POS for Retail Administrator

Note: It's important that you set up your QuickBooks company file before you go on.

1 Shut down all running programs and any virus protection software you may have. 
(Some virus protection software can interfere with the Installer.)

2 If the POS for Retail CD isn’t in your computer's CD-ROM drive, insert it now. The 
installer should start in a few moments.

Note: If the Installer doesn't start automatically, from the Windows Start menu, 
select Run. Type the drive letter associated with your CD-ROM drive, then 
type :\autorun.exe and click OK (for example, d:\autorun.exe).

3 In the Welcome to POS for Retail window, click Install POS for Retail Administrator.

4 In the Welcome to POS for Retail Setup Wizard window, click Next to begin.

5 In the End User License Agreement window, click Yes after reading the agreement.

6 In the Select Install Location window, click Next to select the default folder or click 
Browse to navigate to the folder you want.

7 From the Start Copying Files window, click Next to begin copying the necessary POS 
for Retail Administrator files to your computer.

8 Click Finish and when you are prompted to reboot your computer, click Yes.

9 Once your computer has rebooted, follow the steps below to register and setup POS for 
Retail Administrator.
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Running POS for Retail Administrator for the first time

Before configuring terminal hardware and/or installing POS for Retail, you'll need to set up 
a few options in POS for Retail Administrator. To run POS for Retail Administrator:

1 On your Windows desktop, double-click the POS for Retail Administrator icon. The 
Welcome to POS for Retail Administrator window appears.

2 Click Next. The POS for Retail Administrator License Key window appears.

3 Enter your License Key and click Next. You can find your license key on the License Key 
Card. When you click next the POS for Retail Administrator Registration Number 
window appears.

4 To obtain a registration number, contact Intuit Canada (1-800-250-9845). When you 
have received your registration number, enter it into the Registration Number field.

5 Click Next. The POS for Retail Database Location window appears.

6 Click Next to accept the default POS for Retail Administrator database file (POS for 
Retail.PDB) or if you have an existing database file, click Find to automatically locate it 
on your hard drive.

7 In the QuickBooks Data Location window, type the path for your QuickBooks company 
file (.QBW) or click Find to automatically locate it on your hard drive.

8 Click Next to continue. The Select a Province window appears. Select the province that 
your company does business in. 

Note: The province selected here should be the same as the province selected in 
your QuickBooks company file.

9 Click Next to continue. The ‘Build the POS for Retail Database’ window appears.

10 Click Next to build the POS for Retail database. Items and accounts are added to the 
QuickBooks data file for POS for Retail to use and the ‘POS for Retail.PDB’ is created 
using data from your QuickBooks company file.

11 When the database is built, click Finish. The ‘Transfer Data from QuickBooks’ window 
appears.

12 Click Next to continue. The ‘Select Transfer Information’ appears.

13 Click Next to transfer the data from QuickBooks. POS for Retail Administrator transfers 
the listed files from QuickBooks to populate the ‘POS for Retail.PDB’ database file. By 
default all of the Transfer Information is selected.

14 When the file transfer is complete, click Finish. The POS for Retail Administrator 
Options screen appears to allow you to configure some necessary options for POS for 
Retail.

15 For a detailed explanation of all options, see “POS for Retail Administrator Functions” 
on page 62 of the ‘Point-of-Sale User’s Guide’. It isn't mandatory to set all options 
before installing POS for Retail.

16 When you are finished setting the POS for Retail Administrator options, close POS for 
Retail Administrator.
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3. Setting up Sales Terminal Hardware
The following setup instructions are for the sales terminal hardware shipped with the 
‘QuickBooks Point-of-Sale Complete Solution for Retailers’ product. If you have purchased 
your terminal hardware separately, these setup instructions may not apply.

Welch Allyn Imageteam 3220 Barcode Scanner

Before starting, disconnect the keyboard from the computer.

1 Plug the keyboard into the barcode scanner cord.

2 Plug the free end of the barcode scanner cord into the keyboard slot on the back of your 
computer.

Fig. 1

For information about configuring your barcode scanner in POS for Retail see ‘The Scanner 
tab’ on page 95 of the POS for Retail User’s Guide.

Before you start

Make sure your computer is turned off prior to connecting the new sales ter-
minal hardware.
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Star TSP600 Thermal Receipt Printer

Connect the receipt printer to the computer with the enclosed serial cable. One end of the 
serial cable connects to the back of the receipt printer and the other end connects to the 
serial (COM) port on the back of the computer. The adapters at either end of the serial cable 
are designed to only fit one way.

Plug one end of the power supply into the back of the receipt printer and plug the other 
end into the power source.

Fig. 2

For information about configuring your receipt printer in POS for Retail see ‘The Receipt 
Printer tab’ on page 98 of the POS for Retail User’s Guide. 

MS Generic Cash Drawer

The cash drawer connects to the receipt printer. The cash drawer’s connection looks like a 
phone jack. One end is already connected to the back of the cash drawer and the other end 
plugs into the back of the receipt printer.

Fig. 3

For information about configuring your cash drawer in POS for Retail see ‘The Cash Drawer 
tab’ on page 100 of the POS for Retail User’s Guide.
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4. Installing QuickBooks POS for Retail

To install POS for Retail on a single terminal
1 Shut down all running programs and any virus protection software you may have. 

(Some virus protection software can interfere with the Installer.)

2 If the POS for Retail CD isn’t still in your computer's CD-ROM drive from installing POS 
for Retail Administrator, put it in. The installer should start in a few moments.

Note: If the Installer doesn't start automatically, from the Windows Start menu, 
select Run. Type the drive letter associated with your CD-ROM drive, then 
type :\autorun.exe and click OK (for example, d:\autorun.exe).

3 In the Welcome to POS for Retail window, click Install POS for Retail.

4 In the Welcome to POS for Retail Setup Wizard window, click Next to begin.

5 In the End User License Agreement window, click Yes after reading the agreement.

6 In the Select Install Location window, click Next to select the default folder or click 
Browse to navigate to the folder you want

7 From the Start Copying Files window, click Next to begin copying the necessary POS 
for Retail files to your computer.

8 Click Finish. Click Yes to reboot your computer.

9 Follow the steps in the next section to run and setup POS for Retail.

Running POS for Retail for the first time

Before running POS for Retail, you'll need to set up a few options. 

To run POS for Retail:

1 On your Windows desktop, double-click the POS for Retail icon. The Welcome to POS 
for Retail window appears.

2 Click Next. The POS for Retail License Key window appears.

3 Type your License Key, then click Next. You can find your license key either on your 
POS for Retail CD case or on the back of your POS for Retail User Guide.

4 To obtain your registration and activation numbers, contact Intuit Canada (1-800-250-
9845). When you have received your registration and activation numbers, enter them 
into the corresponding fields.

Note: For each computer that requires POS for Retail, you will need to acquire a 
unique registration and activation number.

5 In the POS for Retail Terminal ID window, click Next to accept the default ID or type a 
new ID. The default ID is your computer name.
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6 In the POS for Retail Database Location window, type the path for your POS for Retail 
database (POS for Retail.PDB) or click Find to automatically locate it on the hard drive 
of the computer where POS for Retail Administrator is installed.

POS for Retail needs to point to the POS for Retail.PDB (POS Database) for all the 
necessary information (for example, Inventory).

7 Click Next to continue.

8 Click Finish to complete this step. POS for Retail opens the QuickBooks POS for Retail 
Options window.

For more information on all the options, see “Setting Up POS for Retail” on page 86 in the 
User Guide.

To install POS for Retail on a Network

Implementing POS for Retail on a network may require the expertise of your computer 
supplier or a network administrator.

In order for POS for Retail to perform correctly, files need to be shared between computers. 
This is a task for an expert. If you are an expert PC user then you will have no problem 
defining the network drives on each PC. If you are not an expert PC user, ask your supplier 
to configure the network and software for you.

Note: QuickBooks and POS for Retail Administrator must be installed on the same 
machine.

To set up one or more terminals in your store
1 Ensure that all of your machines (the back-office computer and all terminal computers) 

are on the same network.

2 Share the drive containing the ‘POS for Retail.PDB’ database file and map this drive on 
the other machines. We recommended that the drive be on the back-office computer.

3 Map a drive on the back terminal to each front terminal.

4 Make the back office machine the designated QuickBooks and QuickBooks POS for 
Retail Administrator computer.

5 On your terminal computers map a drive to the back office computer and install POS 
for Retail on each terminal. When you are prompted to locate the ‘POS for Retail.PDB’ 
it will be found on the mapped drive (on the back office computer).
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5. Setting up Electronic Processing of Credit 
and Debit Transactions

Having Electronic Processing of Credit and Debit Transactions available at your retail 
terminal reduces the possibilities of credit card and debit card fraud. It is faster, easier, more 
secure and less prone to operator error.

To get Electronic Processing of Credit and Debit Transactions working for you, you need to 
rent a swipe PINpad and apply for Moneris Solutions’ Electronic Credit and Debit 
Transaction Processing service.

Contact Moneris Solutions
1 To apply for Moneris Solutions’ Electronic Processing of Credit and Debit Transactions 

service, call 1-866-681-4119. When you call Moneris Solutions, you will need to 
provide them with several important pieces of information so that they can determine 
if they are able to provide their service to you. This information includes business 
name, address, and which types of cards you wish to accept via electronic processing.

2 Once approved, you are registered with Moneris Solutions and sent four items:

a) A Welcome letter - This letter is sent by fax or mail and contains your 13 digit 
merchant number and Moneris Solutions’ service/support phone number.

b) Electronic Processing Setup Letter - This letter is sent by fax or mail and 
contains the following information about your electronic processing 
connection:

- Host dial-up Telephone Number

- 13 digit Merchant Number

- Debit Terminal ID

- Credit Terminal ID

c) Electronic Processing Start-up Kit - This kit contains electronic processing 
documentation, credit card carbon copy slips and the terms and conditions of 
your agreement with Moneris Solutions.

d) Your PINSmart PINpad.

If approved, you should receive the above items within seven to ten business days of 
applying with Moneris Solutions.

Installing and Configuring your PINSmart PINpad

The PINSmart PINpad provided by Moneris Solutions comes with a three-way cable:

1 Connect the end of the cable that looks like a phone jack plug to the PINpad.

2 Plug the PINpad into an electrical outlet and attach the free end of the cable to a COM 
port on your retail terminal computer.

3 Open POS for Retail on the retail terminal that you have the PINpad connected to.
5. Setting up Electronic Processing of Credit and Debit Transactions 13



4 From the Tools menu, select Options. The Options dialog appears.

5 Select the ‘Elec. Processing’ tab. and select the ‘Enable Electronic Processing of Credit 
and Debit Transactions’ checkbox.

6 Select the COM port that your PINpad is connected to from the ‘Connected to’ drop-
down list.

Configuring Electronic Processing
1 Open POS for Retail. From the Tools menu, select Options. The Options dialog appears.

2 Select the ‘Elec. Processing’ tab and click Settings. The Electronic Processing Settings 
dialog appears.

3 If you are using a dial-up connection for your electronic processing of transactions, 
select ‘Dial (Private)’ from the ‘Line Type/Protocol’ drop-down list. If you are using an 
IP connection for your electronic processing of transactions, select ‘TCP/IP’ from the 
‘Line Type/Protocol’ drop-down list.

Note: Before you begin setting up your TCP/IP connection in POS, you must set up a 
Windows VPN connection. Please call an Intuit customer support representative at 1-
800-250-9845 for help with this process

4 If you are using a dial-up connection for your electronics processing of transactions, 
enter the phone number provided by Moneris Solutions into the Telephone Number 
field. If you are using an IP connection for your electronic processing of transactions, 
enter the IP Address and Port number in the given fields.

5 In the General tab of the Electronic Processing Settings dialog, enter the 13-digit 
Merchant Number, Debit Terminal ID and Credit Terminal ID provided by Moneris 
Solutions in the given fields.

6 Select your primary language of business from the ‘Default Language’ drop-down list.

7 Select the ‘Card Types’ tab. By default Bank Card / Debit, VISA, and MasterCard are 
selected. If, when you applied with Moneris Solutions you purchased support for 
American Express, Enroute / Diners, or Discover credit cards, select the corresponding 
checkbox here. If you would like to purchase electronic processing capability services 
for any of these cards, contact Moneris Solutions.

8 Select the ‘Cardholder Agreement’ tab. If you would like to edit the text that is printed 
on the bottom of your electronic processing receipts, you can do so here.

9 Select the ‘Modem and PINpad’ tab.

10 The default PINpad configuration is for the PINSmart PINpad provided by Moneris 
Solutions. Ensure that the ‘PINpad Port’ field is set to the COM port that your PINpad 
is connected to.

11 The default modem configuration is for a US Robotics modem. If you are using a dial-
up connection, ensure that the ‘Modem Port’ field is set to the COM port that your 
modem is connected to.

12 Click OK to save your electronic processing settings and return to the Options dialog. 
Click OK to save your options and return to POS for Retail.
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Updating your POS touch-screen

Using electronic transactions in POS requires that you have electronic transaction (Visa, 
Mastercard, Debit Transaction etc.) buttons on your POS touch-screen. Follow these steps 
to import a customized screen:

1 Ensure that the POS Installation CD is in your CD-ROM drive.

2 From the Tools menu, select Options. The Options dialog opens.

3 Select the Keyboard tab and press ‘Copy Layout’ in the ‘Touch Keyboard’ section. The 
Copy Layout dialog opens.

4 Select the ‘From Disk’ tab and click Browse.

5 Navigate to the CD-ROM drive and open the ‘Support’ folder. Select ‘electronic 
processing.tkz’ and press ‘Open’.

6 Click OK to close the ‘Copy Layout’ dialog. Click OK to close the Options dialog. A 
customized POS touch-screen should now be on your screen.

Fig. 4

For more information about setting up buttons for electronic processing of transactions see 
“Appendix 2 - Setting up new touch-screen buttons” on page 22.
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6. Entering Credit and Debit Card Transactions

Initializing your electronic transaction host connection
1 From the Tools menu select Options. The Options dialog appears.

2 Select the Elec. Processing tab. If the ‘Enable Electronic Processing of Credit and Debit 
Transactions’ checkbox is not selected, select it now.

3 Press OK. If your connection settings have been configured correctly, it is initialized. If 
you are using a dial-up connection, you will be connected twice and if the initialization 
is successful, your receipt printer prints ‘Electronic Processing Initialized’. If there are 
any errors in the initialization, your receipt printer will print ‘Electronic Processing 
Initialization Failed’ followed by a description of the error.

If you are encountering technical difficulties or problems initializing, please contact an 
Intuit customer service representative at 1-800-250-9845.

Performing Electronic Credit and Debit Transactions

The following section shows you how to carry out some basic electronic transactions in 
QuickBooks POS for Retail.

Performing a typical electronic transaction
1 Enter the items to be purchased, and then press the appropriate credit or debit card 

button to accept an electronic payment. For example, press the VISA button for a VISA 
transaction.

2 For debit transactions, your customer should now follow the instructions displayed on 
the PIN pad, such as swiping the card and selecting the account type.

3 If the transaction is approved, the electronic transaction is processed by Moneris Solu-
tions, the receipt printer prints the receipt, and the transaction is complete.

4 If the issuing bank declines the transaction, a message is displayed on your screen. 
Choose another form of payment or press Cancel on the POS keyboard or touch screen 
to cancel the sale altogether.

Performing an electronic transaction with cash out

Before giving cash back to a customer on an electronic debit transaction, you must 
configure your ‘Debit Card’ button to allow cash out.

Configuring your Debit Card button to allow cash out
1 From the Tools menu select Options.

2 Select the Keyboard tab and click ‘Design Touch Keyboard Layout’.

3 Select the ‘Debit Card’ button or any other button you want to enable cash out for and 
click ‘Show Functions’.
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4 Select the ‘Allow Cash Out’ checkbox and click ‘Cash Out Options’.

5 Select your ‘Asset Account Decreased’ and ‘Asset Account Increased’ accounts and press 
OK. For more detail about the ‘Allow Cash Out’ option see “Appendix 2 - Setting up 
new touch-screen buttons” on page 22 of this startup guide.

6 Click OK to save these options and return to POS for Retail Options dialog. Click OK in 
the Options dialog to return to POS for Retail.

Performing an electronic transaction with cash out
1 Enter the items to be purchased.

2 Enter an amount equal to the purchase total plus the amount of cash out, then press 
the ‘Debit Card’ button on your touch-screen.

For example, if the sale totals $10.00, and the customer requires $20.00 cash, enter 
$30.00 and press the ‘Debit Card’ button. 

3 For debit transactions, your customer should now follow the instructions displayed on 
the PIN pad, such as swiping the card and selecting the account type.

4 If the transaction is approved, the electronic transaction is processed by Moneris Solu-
tions, the receipt printer prints the receipt, and the transaction is complete.

5 If the issuing bank declines the transaction, choose another form of payment or press 
Cancel on the POS keyboard or touch screen to cancel the sale altogether.

Entering an Electronic Transaction refund
1 For each item to be returned, click Refund on the keyboard or touch screen and then 

enter the item to be returned. 

2 Press the appropriate debit or credit card button to refund the amount by electronic 
transaction.

3 For debit transactions, your customer should now follow the instructions displayed on 
the PIN pad, such as swiping the card and selecting the account type.

If your Electronic Debit or Credit transaction times 
out

After you press a debit or credit card button, the PIN pad sits in a waiting mode for 
approximately 50 seconds until the user responds to the prompts. If there is no activity 
within that period, the PINpad cancels the transaction that was sent.

If this happens, press the credit or debit card button to send the amount to the PINpad 
again. Similarly, if an electronic debit or credit transaction is cancelled on the PINpad, you 
must also press the Cancel key on the POS keyboard or touch screen.
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Manually entering credit cards

If a customer's card won't swipe or you receive an order by phone or mail, you can manually 
enter the credit card number before you can process it electronically.

1 Enter the items to be purchased, and then press the appropriate manual credit card 
button to manually enter a credit card number for an electronic payment. For example, 
press the ‘Manual VISA’ button for a manual VISA transaction.

2 Enter the credit card number and expiry date in the given fields.

3 If the customer and the customer’s credit card is present, select ‘Card Present’. If the 
customer’s credit card is not present select ‘Mail/Phone Order’

.

Caution: Card could be counterfeit

If anything about the shopping pattern or the cardholder is suspicious, a Code 
10 call should be made. If comfortable with the sale, an imprint of the credit 
card must be taken.

It is very important that you select ‘Mail/Phone Order’ if the credit 
card is not present.

Credit card companies require that transactions that are processed when the 
card is not present are noted as such.
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7. Completing the End-of-day Process

In POS for Retail

If you have tendered any electronic transactions, you need to create a settlement report, 
and transmit it to the appropriate financial institutions. This is done through the end-of-
day process.

To initiate an Electronic Processing settlement
1 In QuickBooks POS for Retail, choose End-of-day Process from the Tools menu.

2 When you get to the Electronic Processing Settlement screen, select ‘Initiate Electronic 
Processing Settlement’, and click next.

The electronic transactions are totalled and sent to the proper financial institutions; 
and the receipt printer prints a settlement report for your records. The electronic trans-
action totals in QuickBooks POS for Retail are reset for the next day

In POS for Retail Administrator

When the end-of-day process is complete in POS for Retail, click POST in POS for Retail 
Administrator. Follow the steps in the ‘Post’ wizard. This transfers all of the days 
transactions into QuickBooks.
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Appendix 1 - Working with Barcodes

Re-Configuring your Barcode Scanner

Your Welch Allyn IT3220 barcode scanner should be configured for use with QuickBooks 
POS for Retail directly out of the packaging. If you run into trouble getting it to successfully 
scan a barcode into POS, please try the following:

Ensure that your barcode scanner has power, your system is turned on, and this piece of 
paper is on a flat surface easily accessible to the barcode scanner’s beam. It is recommended 
that you use another sheet of blank paper to cover up the barcodes you are not working 
with so as not to accidentally scan the wrong ones in.

You should hear an audible beep from your scanner at the successful scan of each one of 
these barcodes:

1 Scan this barcode to enter the scanner into programming mode:

2 Scan this barcode to tell the scanner to enter the preamble mode to set your prefix:

3 Scan these two barcodes to set the prefix to tilde.

4 Next, scan this barcode to end the prefix set.

5 Scan this to exit the programming mode.

Your barcode scanner is now set up to work properly for the QuickBooks Point-of-Sale 
software!
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Printing your own barcode labels

Intuit recommends that you use a non-coated or non-glossy barcode label stock when you 
are printing your own barcode labels for your product. This is sometimes referred to as satin 
or matte finish. This will ensure scanning accuracy for your barcode scanner.

Glossy or coated stock may cause reflections which barcode scanners can have difficulty 
scanning properly.
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Appendix 2 - Setting up new touch-screen 
buttons

For more information about adding buttons the POS touch-screen, see ‘Touch keyboard 
layout’ on page 94 of the Point-of-Sale User’s Guide.

For new buttons to be used with Electronic Processing of Credit and Debit Transactions, use 
the ‘Tender Electronic Trans’ function.

‘Tender Electronic Trans’ Function Options

The new ‘Tender Electronic Trans’ function tracks electronic debit and credit card 
payments, and can also trigger a connected PINpad if one is connected to QuickBooks POS 
for Retail. 

Following are the options that you can set for the ’Tender Electronic Trans’ function. By 
default, these options should already be set up for you. This information is for reference 
only:

Option Description

Caption What you type here is displayed on-screen and printed on receipts and 
reports when using the Tender Electronic Trans key.

Open the 
Cash Drawer

Opens the cash drawer when a Tender electronic transaction occurs.

Compulsory 
Amount Ten-
der

Forces the operator to enter the payment amounts before pressing the 
Tender Electronic Trans key.

Enforce 
Receipt Print

Forces the Tender electronic transaction to print a receipt regardless of 
whether the Receipt On/Off function is turned off.

Enforce 
Invoice Print

Forces the Tender electronic transaction to print an invoice.

Print Dupli-
cate Receipt

Prints a duplicate receipt for this Tender electronic transaction.

Use Elec-
tronic Pro-
cessing

Looks for an integrated PINpad, and passes the transaction amounts to 
the device. If a PINpad is not configured for this system, the option is 
ignored, and the transaction treated as a manual electronic Tender.
If neither Debit nor Credit is selected when ‘Use Electronic Processing’ 
is enabled, then a message displays when the Tender Electronic Trans 
key is used asking if this is a credit card. Selecting ‘Yes’ initiates a credit 
card transaction on the PINpad. Selecting ‘No’ initiates a debit card 
transaction.
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Debit When ‘Use Electronic Processing’ is enabled, select this to process 
debit card or Interac transactions. The PINpad then allows for debit 
card swiping, and prompts for the customer's PIN number and account 
type. If the authorization fails, the transaction must be tendered using a 
different function, or cancelled altogether.

Credit When ‘Use Electronic Processing’ is enabled, select this to process 
credit card transactions. The PINpad then allows for credit card swip-
ing. If the authorization fails, the transaction must be tendered using a 
different function, or cancelled altogether.

Manual CC# 
Entry

Opens the ‘Manually Enter Credit Card Information’ dialog. This option 
is only available when the ‘Credit’ checkbox is selected.

Minimum 
Amount

Sets the minimum sale amount allowed to perform a Tender electronic 
transaction. An amount of 0.00 means there is no minimum set.

Payment 
Item

This option is required to record the transaction in QuickBooks. A 
default ‘Electronic Transaction’ payment item is created in QuickBooks 
during installation of QuickBooks POS for Retail Administrator. By 
default, the correct payment item should be selected for the appropri-
ate ‘Tender Electronic Trans.’ function.

Allow Cash 
Out

Allows the operator to give cash out to customers who wish to with-
draw money from their account. The following options must be set to 
record the transaction in QuickBooks. To access these options, click 
Cash Out Options.
� Caption:  Text entered here is displayed on the screen as well as 

receipts and reports when the ‘Tender Electronic Trans.’ key is used.
� Asset Account Decreased:  As Cash Out transactions reduce the cash 

in hand from the register, the amount must be tracked in Quick-
Books. Click this button to display a list of accounts from which to 
select. Highlight the appropriate account, and select OK. 

Note: Accounts are created in QuickBooks when QuickBooks POS for 
Retail Administrator is first opened. If you do not have an 
appropriate account already set up in QuickBooks, we 
recommend you use the ‘Cash Register Funds’ account.

� Asset Account Increased: As Cash Out transactions increases the 
cash in hand from the register, the amount must be tracked in Quick-
Books for bank reconciliation purposes. Click this button to display a 
list of accounts from which to select. Highlight the appropriate 
account, and select OK.

Note: Note: Accounts are created in QuickBooks when QuickBooks 
POS for Retail Administrator is first opened. If you do not have 
an appropriate account already set up in QuickBooks, we 
recommend you use the ‘Undeposited Funds’ account.

Option Description
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